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Overview

This article provides a quick overview on how to import voter history data from a .csv file. It links to an example spreadsheet you can download to
see how the columns required to be structured for this import.

If you need a hand with this please give us a call on our support line 1-866-909-8700. You may also need to send us your file so the data can be
‘flipped’ correctly so that elections are listed as rows instead of columns.
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PAY ATTENTION

THIS IS IMPORTANT?

IMPORTANT! The voters must be in your database *prior* to importing voter history AND they must have SOS numbers. These videos will get you
started with running an import of voters.

« Tip: Start a new session of Trail Blazer before running the import, and close it afterwards. It will make it a lot easier to pinpoint the session and
roll-it-back if a mistake is made. You can also run a sample import of a few hundred records before importing a large list.
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Steps

IMPORTANT: When you open your .csv file in Excel, the leading zeros on the voter SOS numbers will be stripped (if they lead with a zero vs a
letter). Here’s an example:

A B
$0S as it appears when
505 as provided by Board opened in Excel if care is
1 of Elections not taken
r 0000123456758 12345678

You need to take the necessary steps to open the file in Excel without stripping the leading zeros or the data won’t merge properly with the existing
data in your database. There are a variety of resources on Google that walk through the steps to open your .csv properly:
https://www.google.com/?gws rd=ssl#newwindow=18&qg=excel+dropping+leading+zeros+csv

Here’s the link to download our spreadsheet template which provides the required column mapping for voter history imports, along with notes,
and tips.
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Once you’ve downloaded the spreadsheet, remove the columns you don’t need, remove the tip section, and remove the *first row* (which is just
a guideline). Then replace the data in our example spreadsheet with your voter history date. In my example | left the columns as is, and just
removed the first line and the tip section.

IMPORTANT: The Columns for ‘electionname’ and ‘election type’ will not be imported — you can either DELETE them from the spreadsheet prior
to importing, or leave them as is. When you get to the column mapping part of the process, map them as Do not Import.
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Remove the columns you don't need, the first row (so only the headers remain),
and then save the file as a .csv file type.

@' = - = Voter History Required Formatxlsx - Microsoft Excel @ﬂlﬂ
Hame Insert Page Layout Formulas Data Review View Developer Team & e = EP E3
_uj * i Calibri T13 v AN = = %] P S Wrap Text General - ij‘ ﬁ g E- §< E\ 5: % [ﬁ
|y Blzu A- O Suenaceias S % 0 WS gret e oo | oo o sne s f
Clipboard [P Alignment [P Number [P Styles Cells Editing

Al - 505 A

r

e
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1 |sos CountyCode voterhistory votedtype votedparty electionname election type E
2 | 97012686 6/7/2016 Voted by Vote By Mail DEM Presidential Primary 2016 Primary
3 18436 6/7/2016 Voted by Vote By Mail REP Presidential Primary 2016 Primary
4 13436 11/4/2014 Voted by Vote By Mail 2014 Consolidated General Election General
5 18436 11/6/2012 Voted by Vote By Mail November 6 2012 Presidential General Election  General
N 6 18436 11/2/2010 Voted by Vote By Mail November 2 2010 Consolidated General Election  General
7 18436 11/4/2008 Voted by Vote By Mail November 4 2008 General Election General
8 11242 11/6/2012 Voted at polling Place MNovember 6 2012 Presidential General Election  General
'l 9 11242 11/2/2010 Voted at polling Place November 2 2010 Consolidated General Election  General
10 11242 11/4/2008 Voted at polling Place November 4 2008 General Election General
11 26458 11/6/2012 Voted at polling Place MNovember 6 2012 Presidential General Election  General
12 26458 11/2/2010 Voted at polling Place Movember 2 2010 Consolidated General Election  General
13 26453 11/4/2008 Voted at polling Place November 4 2008 General Election General
14 368 6/7/2016 Voted by Vote By Mail NP Presidential Primary 2016 Primary
15 368 11/4/2014 Voted by Vote By Mail 2014 Consolidated General Election General
16 368 11/6/2012 Voted by Vote By Mail November 6 2012 Presidential General Election  General
17 368 11/2/2010 Voted by Vote By Mail November 2 2010 Consolidated General Election  General
18 368 11/4/2008 Voted by Vote By Mail November 4 2008 General Election General
19 40348 11/6/2012 Voted by Vote By Mail November 6 2012 Presidential General Election  General
20 23958 6/7/2016 Absentee issued but not returned REP Presidential Primary 2016 Primary
21 23958 11/6/2012 Absentee issued but not returned November 6 2012 Presidential General Election  General
22 23958 11/2/2010 Absentee issued but not returned November 2 2010 Consolidated General Election  General
23 23958 11/4/2008 Voted by Vote By Mail Movember 4 2008 General Election General
24 39862 6/7/2016 Absentee issued but notreturned REP Presidential Primary 2016 Primary
25 39862 11/4/2014 Absentee issued but not returned 2014 Consolidated General Election General
26 39862 11/6/2012 Absentee issued but not returned Movember 6 2012 Presidential General Election General
27 39862 11/2/2010 Voted by Vote By Mail November 2 2010 Consolidated General Election  General
28 39862 11/4/2008 Voted by Vote By Mail November 4 2008 General Election General
29 24428 6/7/2016 Voted at polling Place REP Presidential Primary 2016 Primary
30 24428 11/4/2014 Voted at polling Place 2014 Consolidated General Election General
Aol 29 2344909 117019 Vearad a+ nAallivea Dlamrs Plruamiblare M1 Dracidamti=asl camars]l Clacdie e mamearsl



http://www.trailblz.com/kb

& TrailBlazer

Organtze.Leverage. Succeed. Importing Voter History Data — Import Steps and Example Spreadsheet
with Required Column Formatting — Political Only

Note: The column labeled ‘VoterHistory’ will create the name(s) of the election(s) in the database, so you could name them something like
‘General Election MM/DD/YYYY’ so that it makes more sense once the data is uploaded, or you can change these after the upload completes
(covered later in this article).

Once the file is prepped, save it as a .csv file type. Make sure not to include special characters in the file type, my example is below.
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SaveAs . e ——— " J e —

——,
{ ilU | & » Computer » Local Disk (C:) » Users » jkristenson » Downloads - |ﬂ~|| Search Downloads

Organize « Mew folder A=

Microsoft Excel - Date modified Type
i Mo iterns match your search.
W Favorites
Bl Desktop
L Temp
& Downloads

=
=1 Recent Places

Bl Desktop
= Libraries
@ Documents
Ji Music
[ Pictures
B videos
2 jkristenson
1 Computer
?! Metwork
(3 Control Panel
= Recycle Bin .
T feree 2. Choose .csv as the file type,

I\ Sales — and click [Savel.

. Support, Data & Training

-

Save as type: | C5V (Comma delimited) (*.csv)

File name: | 2016 US Election - Voter History for the Entire Country - Adjusted for Import.csv / \

Authors: MPANGER Tags: AYd atag Title: Add a title

& Hide Folders
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You’ll get a warning when saving as a .csv, click [Save] to continue.

Microsoft Excel - —— ——

2016 US Election - Voter Histary for the Entire Country - Adjusted for Import.csv may contain features that are not compatible with CSV {Comma delimited). Do you want to keep the workbook in this format?
I

» To keep this format, which leaves out any incompatible features, dick Yes.,
s To preserve the features, dick No. Then save a copy in the latest Excel format.
+ To see what might be lost, dick Help.

Click [Yes] when prompted.

Once the file is saved as a .csv, close the spreadsheet. Click [Don’t Save] if Excel prompts you again with a warning.
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—
2016 US Election - Voter History for the Entire Country - Adjusted for Import.csv - Microsoft Excel = 53_.'
Page Layout Formulas Data Review View Developer Team & g o 3
_ 0 o -
13 A == %] B S Wrap Text General - #;] ﬁ Q il- %‘ L!_—\ z . % ﬁ
fy - A o @I\ﬂerge B Center~ | % - % “8 3% | Conditional Format  Cell Insert Delete Format . Sort & Find &
Formatting = as Table = Styles = o = = Filter~ Select~
pnt [F] Alignment [P Mumber [P Styles Cells Editing |
F | sos A
s
v
B c D E F G RS
L voterhistory votedtype votedparty electionname election type =]
6/7/2016 Voted by Vote By Mail DEM Presidential Primary 2016 Primary
6/7/2016 Voted by Vote By Mail REP Presidential Primary 2016 Primary
11/4/2014 Voted by Vote By Mail 2014 Consolidated General Election General
11/6/2012 Voted by Vote By Mail Movember 6 2012 Presidential General Election  General
11/2/2010 Voted by Vote By Mail Movember 2 2010 Consolidated General Election  General
11/4/2008 Voted by Vote By Mail November 4 2008 General Election General
11/6/2012 Voted at polling Place November 6 2012 Presidential General Election General
11/2/2010 Votedatnalling Blaca B har3 2010 Consolidated General Election  General
11/4/2008 votd Microsoft Excel General Election General
11/6/2012 Vot ”i\‘ 12 Presidential General Election  General
11/2/2010 votd | /2% E‘;c\‘hf’o“n"ﬁ':fb:‘: i‘gﬁ%ﬁ;’;%:ﬂ)::“&jﬁﬁ igjti;’esd 10 Consalidated General Election  General
11/4/2008 vot for Import.csv2 General Election General
6/7/2016 Vot [ — ey pe— rimary 2016 - Primary
11/4/2014 Vot ated General Election General
11/6/2012 Vot 012 Presidential General Election  General
11/2/2010 Voted by Vote By Mail Movember 2 2010 Consolidated General Election  General
11/4/2008 Voted by Vote By Mail Movember 4 2008 General Election General
11/6/2012 Voted by Vote By Mail Movember 6 2012 Presidential General Election  General
6/7/2016 Absentee issued but notreturned REP Presidential Primary 2016 Primary
11/6/2012 Absentee issued but not returned Movember 6 2012 Presidential General Election  General
11/2/2010 Absentee issued but not returned Movember 2 2010 Consolidated General Election  General
11/4/2008 Voted by Vote By Mail Movember 4 2008 General Election General
6/7/2016 Absentee issued but not returned REP Presidential Primary 2016 Primary
11/4/2014 Absentee issued but not returned 2014 Consolidated General Election General
11/6/2012 Absentee issued but not returned Nowvember 6 2012 Presidential General Election  General
11/2/2010 Voted by Vote By Mail November 2 2010 Consolidated General Election  General
11/4/2008 Voted by Vote By Mail November 4 2008 General Election General
6/7/2016 Voted at polling Place REP Presidential Primary 2016 Primary
11/4/2014 voted at polling Place 014 Consolidated General Election General
11/6/2012 Voted at polling Place vember 6 2012 Presidential General Election  General
11/2/2010 Voted at polling Place Nyvember 2 2010 Consolidated General Election  General =
- Voter Histor .~ ¥1 4| il | » [
\ [EEER I ——

1. Close the spreadsheet after
prepping it and 'saving’
it as a ‘csv' file type.
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Open your Trail Blazer database and navigate to the Voters (Contacts) list under the Application Menu.

@) Settings Help

Application Menu ot
B

Tasks

fs Dashboard
[ % Commititee
» & Calendar/Tasks
[» % Canwvassing
4 @ Voter
Voters f—

Minnesota Voter List
@ Addresses
@j Households
Voter Relationships
FJ Lawn Signs
€z shared Databases
i “#p Contributions/Pledges
5 7 Product Sales
[ Cf:} Logs
» 7 Polling
I+ 2% Communications
[ 5 Financial
[ % Disclosure
[ % System Manager
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Navigate to File > Utilities > Import. If you don’t see
system administrator.

this it means you don’t have appropriate security clearance and you’ll need to contact your

=» Search @Heset #Ne‘w = H ¥ fli‘
@I

Favorites | General | Address | Household | Vte History | Attribute | C

File ~| Edit » | ) | g Include Gther | Voters

% Communications  »

5 Reporting > fion [ contitute [ Pledae | Fvent | Sales T10a T admin | saL |

Name | Phone | E-Mai | Email Links | Profile | Workc | Demographic

g Utilities v | & Export...

|

Search all name parts EE Delete Import new records h

(anywhere in field)

Merge...

Find Possible Duplicates...

Q
Individual Last Name:
Corporation First/Org Name:
PAC Middle Mame:
Mickname:
Prior Last Name:

Split Couples into Separate Vaters...
Sort in Househeold Walking List Order...

& Edit | Sort ) Format -~ 53 Wrap | &% Export (5 Print @ Summary [[] = |[E Pivet .

= Last First Address . Zip Birth Gen- Reg
0] Hame “ Name MI = Street Street 2 City State - o Date ger County CD SD LD Id
= I
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Click on the ‘Type’ drop-down and select ‘Voter History Add’.

Trail Blazer Import (Step 1 of 3) 3|
Impart File Type: [me SV [Comma Delimited Text) V]
§T1_.rpe: [Vuter History Add i ]

Source Location: ChUsersijkristensontDocuments

|| Database Name:

1. Select 'Voter History Add'
from the drop-down.

Source Aftribute: <skip source setting> d4F New

@ ok |[@cancel |

2. Click [Browse] to locate the
.csv you prepped in the previous

steps.

Locate and select the CSV file on your machine, and then click [Open]. If you don’t see the file make sure you have ‘CSV’ as the file ‘type’ in the

lower-right of the window.
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@) Open A — — — . E -
Jp— —
@O-v &+ jkristenson » Downloads - | 4,.| | Search Downloads pe |
Organize « New folder =+ O @
A R . 505 ,CountyCode,voterhistory,votedtype .
90 Favorites blame llatelmoditied Type Size ,votedpar¥§,e]ectionname,e ection P 3
type
B Desktop |%‘]2015 US Election - Voter History for the Entire Country - Adjusted for Import.csv 9/29/2016 11:20 AM  Microsoft Excel Comma Separated Values File 1,335KB 9%12536 ,,6/7/2016,voted by vote By
| Temp Mail,DEM ,Presidential Primary
2016,Primar
4. Downloads 18436,,6/?/%016,Voted by vote By
5 Recent Places Mail,REP ,Presidential Primary
o 2016, Primary
18436,,11/4/2014 ,voted by vote By
B Deskt M%ri'l ,,2014 Cons_lo'l'idated General
esktop - - Election,Genera
S 1. Locate and select the CSV file you prepped for import. 18436, J1176/9012,voted by vote By
= Mail, ,November 6 2012 Presidential
= Documents General Election,General
ab . 18436,,11/2/2010,voted by vote By
Music Mail, ,November 2 2010 Consolidated
[/ Pictures General Election,General
) 18436,,11/4/2008,voted by vote By
B videos M_‘a'i'l , sNovember J_T 2008 General
e Election,Genera
B jkristenson 11242,,11/6/2012,voted at polling
1% Computer FPlace, ,November & 2012 Presidential
P General Election,General
M Network 11242,,11/2/2010,voted at polling
[ Control Panel Place, ,November 2 2010 Consolidated
- General Election,General
2/ Recycle Bin 11242,,11/4/2008,voted at polling

. Accounting
. Sales
. Support, Data & Trainir

File name: 2016 US Election - Voter History for the Entire Country - Adjusted for Import.csv

Once the file is selected, click [OK].

Place, ,November 4 2008 General
Election,General
26458,,11/6,/2012,voted at polling
Place, ,November 6 2012 Presidential
General Election,General
26458,,11/2/2010,voted at polling
Place, ,November 2 2010 Consolidated
General Election,General

26458, ,11/4,/2008,voted at polling
Place, ,November 4 2008 General
Election,General
368,,6/7/2016,voted by vote By
Mail,NP ,Presidential Primary
2016,Primary

368,,11/4/2014,voted by vote B
Mail,,2014 Consolidated Genera
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Trail Blazer Import (Step 1 of 3)

Import File Type: [Frnm C5Y [Comma Delimited Text)

Type: | vater History Add

Source Location: ChUsersijkristenson\Downloads
%2016 US Election - Voter History for
the Entire Country - Adjusted for

Database Name:

Source Attribute: <skip source setting=

Once your file has been selected, click [OK].

This will bring up the column mapping screen. *If you named the columns in your spreadsheet the same we did in the example spreadsheet they’ll
automatically map to the correct import field—if that’s not the case you’ll need to map them accordingly by selecting the values from the drop-
downs. In my example | left the two columns in my spreadsheet for ‘electionname’ and ‘election type’ which can be mapped to ‘Do not Import’.
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3. After everything is mapped, click [Import].

2) Impaort Voter History

[ 4

Import Details

’ |mport ] [@ Cancel

Source Column Map To Trail Blazer Column

505 [\Fott-lhlumber
CountyCode [County Code
voterhistony [VnterHistnw
votedtype [Voted_'iype
votedparty | vated_Party

electionnamea | Do not Import
election type [Du not Import

[

2. *If you left these two columns in the
spreadsheet you'll leave them as ‘Do not Import'.

1. The columns should
‘automatically' map *if
you left them the same
way we have them in the
example spreadsheet.

(Otherwise you'll need to
click the drop-down and
map them accordingly).
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Click [Import] to proceed.

If everything is working correctly you’ll get a load animation that displays the status of the import. My example is below.
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If the import is running correctly you'll get this load annimation, if it isn't you'll get an error message.

Progress e [ — - -@. i , eﬂlUwDﬂeslUwDemdlﬂher|
Progress
u | .
- Title:
15,373 Records to Import. Processsed 600 Search all name parts
Load time - 0.00:00:08, Records per second = 75 7 (amywhere in field) Suff
12 B
ns/Pledges Import | @ Cancel ]
les
EE Edit | @Sort @ Format = 53 Source Column Map To Trail Blazer Column
ns 2 l 508 [Votemlumber v]
. Lbf;rtne Fifl || CountyCode [county code -
I voterhistory [VutetHistu-w - ]
A o votedtype [Vuted_Type v]
votedparty [voted_party -
electionname [ Do not Import - ]
election type [Du- not Import v]
[

Once the import is complete you’ll get a notification with the results, click [OK]. My example is below.
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(T —— )

15373 Records to import, 15373 Processed.

OK

You'll get a popup message when
the import has finished, click [OK].

Once you're all done you can update voter counts under System Manager > Lists > Election, Voter History > File > Set Voter Counts.
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@) Settings  Help

¢ refresh after count update

ke |

Application Menu

Bx|®

Tasks
I Dashboard
;» &g Committee
» § Calendar/Tasks
[ % Canwvassing
[ % Voter
i & Polling
i+ 5 Communications
[ a Financial
[ % Disclosure
Pl '@ﬁ System Manager
System Gallery
Fl Lists
@ Account Types
=] Candidates
Committee
=| Election
=| Elections, Voter History

Elections, Voting Types
=| Expenditure Refunds
Expenditure Categories
Event Participant Types
=| Voter Salutation Types
=| FEC Expenditure Categor
Funds
=| Internal Import Columns
=| Languages
Lawn Sign Types
=| Lobbyists
=| Log Types
Memorial Types
=| Mations
Mon-Monetary Types
Office Types
Payment Types
=| Precincts
Relationships
Shared Databases
States/Provinces

< Seqpch W Reset [k New (BB = L) ¥ & &
Q
Favorites | 5QL

Tile +| Edit - | 0 | Voter Hlections

| Set Voter Counts 4

Set Impert Code

@ Import State Elections

Favorite Searches

&) Sort B Format ,|B§ Export ¢ Print | ) Pivot |

Voter Elections [ 16 records found |

D

Election Mame

General 2004

Short
Mame

Election Election Type

T
:

Partisan
Election

Import Code
Format

08/14/2004 43004

11,/02/2004

Vater Count

Primary 2005

9/13/2005

09/13/2005

General 2005

11/8/2005

11/08/2005

Primary 2006

9/12/2006

09/12/2006

General 2006

11/7/2006

11/07/2006

Primary 2008

9/9/2008

09/09/2008

General 2008

11/4/2008

11,/04/2008

Primary 2010

8/10/2010

08/10/2010

General 2010

11/2/2010

11/02/2010

General 2011

11/8/2011

11/08/2011 -

Primary 2012

8/14/2012

08/14/2012 -

General 2012

11/6/2012

11/06/2012 -

General 2013

11/5/2013

11/05/2013

Primary 2014

8/12/2014

08/12/2014 PRI...

!!H!!H!l!!!!!!!j

General 2014

11/4/2014

11/04/2014 - GE...

I o
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You can also rename the elections and update other information (such as the dates and contribution limits) by clicking on each election name and
inputting the respective information. My example is below.

§) Settings  Help

Application Menu « || <gwSearch M. Reset |<F New ™= |k ¥ & (S| File - Edit - | & | Blection _
= o

Tasks [Favortes SaL |

3 Dashboard -
|- & Committee @ |
I & Calendar/Tasks .
Favorite Searches
[» % ‘Canvassing @ ’ﬁ o
[ % Voter e
[ 7 Polling LN
I+ 4 Communications Je
- {8 Financial
[ % Disclosure
4 % System Manager L
& system Gallery =
4 [ Lists General 1998 (13) Election Card =
@ Account Types ) Sort ) Format ~ 53 Wrap D& Export (o _ -
@ Candidates File - Edit - | X | @ |
=l Committee o
! Election: General 1993 (11/3)
5 o VOterHistol D BectionName  Stalt h h the diff b
B o o | [ General [ Limts | Pol Watch| 3 - Go through the different tabs
= N = . Election Info - .
il Expenditure Refunds 5 [Geneniioss [ || EStN 0% o and fill out the relevant information
@ Expenditure Categories 14 General 2000 )
£ Event Prtcipant e L s ] e 1|l Etection Date: [ 11/ 3/1998 Dv] such as:
i=| Voter Salutation Types b - Election Type: General ~ H
1= FEC Expenditure Categories L 2 Primary 2002 3 . = ElECtIOI'l Nal’l’le
S rons 2 [ General 2002 State Election Type:
@ Internal Import Columns 3 Primary 2003 ] FEC Code: 61998 = Start/End Date
@ Languages 4 General 2003 [[] Is Recount : H - H
: _ : - Contribution Limi
@ Lawn .Slg” Types 5 Primary 2004 Co .t b.Ut o .ts .
il Lobbyists 6 | Generai200s - Active it for mobile poll watching
@ Log Types 4
= Memaorial Types 1 General 2005
2 Nations 8 o Primary 2006 || Logon= Joel Kristé[l_—_] Save WSaveand Close i @Canoel ]
e 8 General 2006 (= —————— ——
e 7l 147 Genaral 2007 112007 11/.2007 | G007 on
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The Related Resources below link to a variety of similar articles and videos on importing.

909

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources
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Related Resources

3" Party Resource: Google Search for Tutorials on How to Open a .CSV in Excel without Removing Leading Zeros

Article: Import Templates

Article: How to Import Voters, Elections, and Voter History from the State Voter Databases into your Campaign’s Local Database — (Political Only)
Article: Field/Column Mapping When Importing Voter/Donor Data

Article: Start Import
Article: Running an Import of Contact Data from Excel into your Database — Basic Overview

Article: Pre-Import Check

Article: Importing Contributions

Article: Import Information — Definitions and Column Data Type

Article: How to Configure your RDP (Remote Desktop) Setting on a PC to Allow Access to your Clipboard, and Disk Drives

Article: Rollback — Undo Function

Video Playlist: Importing

Trail Blazer Live Support

© Phone: 1-866-909-8700
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® Email: support@trailblz.com
Kl Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.

Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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